Welcome to this little introduction on how to give technical presentations. I hope you will find it useful. The presentation is meant for relative beginners even though even seasoned presenters may find something new in it. Naturally, we don't touch all topics and some only superficially. But once you are aware of some basic ideas you can start a spiral of self improvement.

Note that none of the basic ideas in these slides are novel or invented by me. Rather they are extracted from a set of excellent books listed at the very end.
Here on the title page we already see two principles in action.

**Alignment** is particularly important; it gives structure and order to a slide (or any graphical design). Interestingly, center alignment usually looks weak and unsophisticated. As a basic rule I suggest that you align left if in doubt (also applies to tables BTW). Try it! Beyond that try to align most elements on a slide to something else.

**Contrast** means that if two elements are meant to look different, make them really different. For example, look at the title and my name. The fonts differ in both weight and size which makes it look visually appealing. Try the same with only size or only weight changed; it will look worse. As a general rule, contrast in fonts is achieved by changing at least two attributes among weight, size, color, and font type.
I like this proverb and it fits well. Applied to the topic of this presentation I want to motivate you to strive for quality.

The photo is from istockphoto.com. The color for the text is extracted from the brighter parts of this photo using Photoshop’s color picker (useful trick).

The slide also goes along with one of my major rules: **start your talk with an interesting slide** and certainly avoid a text slide.

Unfortunately, all slides in the remaining talk will look worse than this one.😊
Why do we Care about Presentations?

- In contrast to a paper or other technical writing, you present your work and yourself
- People remember good presentations:
  - Good content
  - Well presented
  - Well-designed slides
- Many of my colleagues and I put a lot of effort into each presentation, and at the beginning of a career it’s even more important

What’s wrong here?

Here is a couple of bullets expressing the motivation for this talk. The text seems reasonable enough but there are some visual shortcomings. Can you tell?
Why do we Care about Presentations?

- In contrast to a paper or other technical writing, you present your work and yourself.
- People remember good presentations:
  - Good content
  - Well presented
  - Well-designed slides
- Many of my colleagues and I put a lot of effort into each presentation, and at the beginning of a career it’s even more important.

Random (and bad) placement of text:
Looks messy

What’s wrong here?

Here, the shortcomings are listed. Note how we violated to some extent the principles from the beginning: alignment and contrast. Let’s fix these.
Why do we Care about Presentations?

- In contrast to a paper or other technical writing, you present your work and yourself

- People remember good presentations:
  - Good content
  - Well presented
  - Well-designed slides

- Many of my colleagues and I put a lot of effort into each presentation, and at the beginning of a career it’s even more important

- Presentations are very important

What’s wrong here? Too much text + only text Conflicts with you talking (more later)

Much better, no? The alignment and the contrast between bullets and sub-bullets creates structure. As a text slide it looks good, but do we really want or need a text slide? (The answer is no as you may imagine.)
Presentations Are Very Important

- You present your work and yourself

- People remember good presentations:

This is a more visual slide designed to convey the same content.

The disadvantage is that now you have to remember what to say. However, if you don't, you are badly prepared anyway.

The big advantage is that people will have more time listening since they are not busy reading (there is a biological reason for this, explained later). Equally important, the visuals make the slide much more interesting. So people are less likely to return to their laptops. This is an important goal, in particular on the first few slides.

On the content: Presentations are a unique chance to connect your work with your person. If you do a good job, people may remember you, which is particularly important in any type of job (academia: at one point you need reference letters; industry: at one point a job up the ladder will open up and they will only consider the people they remember). Unfortunately, most presentations fall far short of this goal and are rather a waste of time for most of the audience. This is your chance: learn how to do it well and you have an edge!

The bottom part conveys that content and visual quality are equally important. And they are. Note that slides that communicate well are also beautiful. This implies (ever had a logics class?) that ugly slides will not communicate well.
Note that I had added an acknowledgment, since the plot was suggested to me by a colleague in my department. **Acknowledging is good style as much as not acknowledging is bad style.** Imagine you create a fabulous data graphic, give it to somebody who uses it and she does not mention you.
Here you see the **natural enemy of the presenter**: the addictive communication device of our times. When you design your talk keep this in mind! If you are boring for 2 or 3 minutes, people will start checking email and all your work was in vain.
Presentation Overview

- Preparation and physical presentation
- Content
- The visual presentation
- Tools: Powerpoint
- Summary

Here is the overview of this presentation.
Presentation Overview

- Preparation and physical presentation
- Content
- The visual presentation
- Tools: Powerpoint
- Summary

Naturally, we start with the first point.
Preparation

- **Do not prepare your talk in the last minute**
  - Not cool
  - Usually: you slacked
  - Result: Bad presentation

- **Length:**
  - Let’s say: 2/3 x minutes

- **Laptop**
  - Charge and bring power cord
  - Boot it up before presentation so possible updates are installed
  - Backup of presentation on USB key

Like many other things, quality requires **sufficient time for preparation**. We are all busy, but preparation is a matter of priority. And, until your are famous, presenting should be a priority for you. Once you are famous you can hire graphics designer to do them for you.

It is hard to give a good rule for the number of slides. For technical presentations, I found that 2/3 times minutes is a good rule of thumb. **And this includes all slides.** Yes, all. Don’t convince you that some are just overview slides and some sort of empty. Does not matter. 2/3, not more. Leave room for you to talk about your slides. In particular about your results (often towards the end).

Boot up your laptop in the morning of your presentation, You do want that the latest OS update installs itself one minute before your talk.
You in Front of the Audience

- **Tools:**
  - Know your laptop
  - Get a remote mouse (means free talking)

- **Be reasonably dressed**

- **Start:**
  - introduce yourself
  - *Acknowledge your co-authors!*

- **Presentation:**
  - Speak clearly, not too fast
  - Look at the audience
  - Don’t put your hands in your pockets, don’t cross your arms

Know your laptop! How often have you seen people trying to figure out how to get the image onto the screen. You lose valuable minutes!

**Absolutely get a remote mouse.** This allows you to roam around freely, stand where you want, and naturally blend the advancing of your slides and animations with your speech.

Sneakers and shabby shorts at a major conference? Are you famous yet?

Superimportant: acknowledge your co-authors. **Not doing this is a crime.** Not kidding. Usually they worked as hard as you (or tried their best to advise you). So their names have to be verbally mentioned. Imagine what you would do if half of the talk is created on your blood and sweat and you watch your colleague talking about it and never mentioning you.
Presentation Overview

- Preparation and physical presentation
- Content
- The visual presentation
- Tools: Powerpoint
- Summary

Now let’s talk about the content.
You have to start your talk with the motivation. What are you doing, why are you doing it and why is it important? (The last two questions are often connected.) **Make sure you really answer these questions.**

**Don't start with a text-only slide** (remember the natural enemy?) but with an interesting visual. The first slide is your best chance to draw the audience in.

If at all possible **give a precise problem statement.** Ideally visualize it. If people don’t know what are you doing, why would they care about how you are doing it?

Show other cool things if appropriate. Hint of the solution? Cool example result? Cool conclusion of your work? Everything that catches attention and makes people want to listen to you.

In long presentations (let's say > 25 minutes), the overview slide helps to reinitialize people. You should help with that by saying something like “I just explained ......, next I will show.” Maybe some people will come back from playing with your natural enemy. Short talks don't need repeated overview slides.
Here is a very standard organization for a technical presentation. Use it if you cannot think of anything better.

Put slide numbers if one of your audience is not on the room (but connected over phone etc.). This way, you can name a particular slide if things get messed up.
Here comes a big one. I just learned this recently. Text and speech is processed in the brain by the same "channels." This means you cannot read and (really) listen at the same time. In contrast, images and speech can be processed in parallel. The consequence is easy, right?

You cannot read and listen at the same time
The previous slide tells us to **minimize text**. Ideally the visuals are on the slide and the text is produced by you. Again, this requires preparation but it's worth it.

Honestly, when did you remember the last time a text only slide?

Further, for text use bullets and be short (no need for complete sentences). Remember, every word on the slide competes with you for the audience's attention.

If you need to have many bullets consider letting them appear as you speak (here, the remote mouse is a must unless you stand right in front of your laptop).

Define every acronym and use them sparingly.

Use the following rule to force yourself to get rid of text. Go to "View Slide Sorter" and make sure no two consecutive slides are text only. Once you mastered that on a regular basis, take it to the next step and avoid text-only slides (except maybe overview slides) altogether.

Since it is so important, I put the slide in red. As an aside, the nice shading effect is standard in the ppt 2007 menu (Shape fill → Gradient).
Technical Content

- **Communicate:**
  - Motivation
  - Problem statement
  - Main idea
  - Main result

- **Do not (try to) communicate:**
  - Every detail of your work

- **Why?**
  - Because people cannot digest much information that quickly
  - You are lucky if they remember anything from your talk

- **How to get across?**

Of course, one of the main goals of your talk is to get the technical content across. This includes the motivation, the exact problem statement, the main idea behind your solution, and your main result.

**Do not try to get every detail of your work across.** It is simply too much for most of the audience. This does not mean you should trivialize but rather focus. This may include going deep for a few slides but not too long, otherwise everybody will be lost.

Did you ever give a talk, presenting all the details of your nice work, and at the end you get a question that shows that not even the problem you are solving came across? Certainly happened to me many times. Find the right balance for your audience (and this may differ by audience).

If many people remember anything from your talk it was a success. Seriously.
In particular if it gets complicated.
Or equation heavy.
This may include properly used animations (don’t fancify).
Note that this goes along with minimizing text but is somewhat different. Here I want to emphasize that complicated technical content has to be visualized to at least some extent to give the audience the right mental picture and at least a basic idea of what you are talking about. This requires practice. Let’s look at a typical situation.
I see this situation very often. A student gives a technical presentation with rather deep technical content. Soon the slides are filled with equations and the students talks vividly about all kinds of details. The audience is long lost since most don’t see these exact equations all the time so they are struggling to create a mental picture.

The interesting thing is that the student most likely does not have the material stored in her brain in the form of equations but probably does have some sort of structure or visualization in her head. So obviously there is a much better way of doing it.
Namely like this. And it communicates immediately. Of course, not everything is a circle but any visual helps. Remember: it is extremely important that people have the right mental picture of what you are doing and how you are doing it. Words mean different things to different people and equations can be quickly understood only by the expert in exactly the same area.

How do you visualize? Draw from your own mental picture of the material.
Simple Examples

- Process: Block diagram

- System: Block diagram

Here are a few simple examples of visualizations. Block diagrams are particularly useful to identify components, how they interact, input and output etc.
A simple figure as on the left can be used to give a problem specification (which you have to include: mentioned in earlier slides). In this example, the authors built the red block called Spiral.

On the right side is a visualization of Quicksort. In the actual talk I let it appear in steps corresponding to the steps in the algorithm.
Complex processes always require a visualization. Here is an example from biology. Note that when it gets this complex, you need time to explain it if you want to.
Getting Technical Content Across (cont’d)

- Repeat one or two key points throughout the presentation
- Use some humor if you can
- Common mistakes:
  - Too many slides
  - Slides too packed
  - Thinking: If it is easy to understand, people will think it’s trivial

Here some more things to remember. The red ones are common mistaked that you have to learn to overcome.
Contents: Miscellaneous

- **Try not to loose people**
  - Sequence of presented material has to be logical
  - Repeating overview slides help to reinitialize people: *“I just explained ….; now we will ….”*

- **Mention (also verbally) related work by names**
  - E.g., Miller and Smith [ISSCR 2003]

- **Conclusions: repeat main ideas/results/messages**

- **Consider backup slides (e.g., additional data) for questions that you expect**

Too many text slides already! In the talk I let these bullets appear one after the other. The two key points here are the use of overview slides to get people back (from the natural enemy; see earlier slide) to listening to you. For example, you just finished explaining you algorithm in all technical glory and now you come to the results. Emphasize this while you talk. Many people are interested in the results even if they did not care too much how you did it.
Presentation Overview

- Preparation and physical presentation
- Content
- The visual presentation
- Tools: Powerpoint
- Summary

Let's talk about the actual design of your slides.
The Looks (The Design)

- As important as content

- Design includes
  - Basic layout
  - Fonts
  - Colors
  - Graphics
  - Data presentation: Viewgraphs, tables

- Basic layout
  - Keep it simple (don’t clutter with logos etc.)
  - **Be consistent**
  - Black text on white background, or
  - **Bright text on dark background**

We argued earlier that the visual quality is as important as the technical content. This is not about adding beauty to good technical content. This is about making slides communicate efficiently. Interestingly, slides that achieve that are beautiful.

As basic layout I prefer black on white since it can also be printed if needed.

A word on logos: do not, I repeat not, stuff something into every corner of your slides. Keep the basic layout (template) empty so you have a lot of real estate. If you want logos, put all into one corner and make them small or avoid them except for the first and last slide (where you can make them larger).

Be **consistent** throughout the talk (same fonts, same colors for the same things, etc.). As you get better you may want to break consistency occasionally if it helps with communicating (an example are the two red slides in this talk).
There is a lot that can be said about fonts but we spend only one slide. Serif fonts (like this one or Times New Roman) have little extensions in every character. This eases the reading of large text blocks like books.

Sans-serif fonts don’t have these extensions and tend to be advantageous in small blocks of text (like headers). Hence use a sans-serif font. My suggestion: use Calibri. It comes with Office 2007 but can also be downloaded for use with Office 2003. Since it is free it can probably used with other software as well.

For code (e.g., a C program) use Courier New bold.

Markus Püschel
http://www.ece.cmu.edu/~pueschel
The math type setting abilities of Office are very limited. First, only very basic symbols are available. Second, it does not look good. Compare the top right (Office) to the top left (texpoint, discussed below).

If you use a lot of math (and do not use latex to make your slides), get texpoint, a latex plugin for Office. This means you can do all the math latex can do and the appearance is equally great. If you have already written a paper, chances are you used latex, so you can just do copy-paste.

Markus Püschel
http://www.ece.cmu.edu/~pueschel
Colors are great and you should use colors. But how?

Often I see the above ones in presentations. They are garish and, well, horrendous. Occasionally there may be a good reason to use such a color but usually not. To look at these on actually needs ....
...glasses.
So if not those then which?
Powerpoint offers these colors at the first level in the color menu. Nothing wrong with the shades of gray. But most of the colors are not really useful, in particular if you need to fill a box or any area. The solution is in the custom tab on the top. Let’s click it.
Colors: Basics

- Use color
  - Pick a few colors and stick with them (consistency)

Avoid fully saturated

Choose somewhat desaturated

We end up with the menu on the right. First we need to understand color models. By default, Office shows RGB (red, green, blue), meaning that every color is specified by 3 values between 0 and 255. However, it is hard to relate these numbers to color.

On the right we show a different model: HSL (hue, saturation, luminosity). H gives the rainbow spectrum, the x-axis above. S gives the saturation, the y-axis above. The fully saturated colors are all on top. All colors from the previous slide are fully saturated. A fully desaturated color is gray. L is the luminosity or brightness, the z-axis so to say and shown by the slider on the right.

If you want a color choose it on top (or on the previous screen), say red, switch to HSL mode, and then desaturate it. The adjust luminosity and fine tune.

See how the desaturated colors look nice. They don’t command as much attention. More on that later.
Here are a few boxes that you can consider. Usually, for larger areas, choose a pastel color = a bright, desaturated color. A box in such a color will serve its purpose but not distract attention. Sometimes dark boxes can be useful. Consider putting white text into it.
The biological process shown uses only pastel colors as does practically any map. In particular maps are a good example of what is called **layering**. A way of overlaying different levels of information inside one visual. These layers can be accessed by refocusing. For example, on the right, you can focus on the ocean and rivers, on the streets, on the cities etc. This is possible due to the choice of colors (subdued = pastel). If every component screamed for attention at the same time one could not look at it.

For example, on slide 23, the bottom block diagram uses some simple layering: the red boxes and the gray area with gray text. Later we will see view graphs that use layering. Below on the page I use layering to de-emphasize the text and the slide numbers.

BTW, do you know where Aveiro is? Did you know CMU has a joined Master's and PhD program with this country?
Data Presentation: Viewgraphs

- **Very readable**
  - Title, x-label, y-label need to be there
  - Fonts large enough
  - Enough contrast (e.g., no yellow on white please)
  - Proper number format (where appropriate)
    - **No:** 13.254687; **yes:** 13.25
    - **No:** 2.0345e-05 s; **yes:** 20.3 µs
    - **No:** 100000; **yes:** 100,000

- **Clearly shows the message**
  - Proper type of plot (line, bars, properly ordered)
  - **Check it:** you know the message; does it jump in your face?

- **Beautiful**
  - Tough, but all the above makes it more beautiful, more later

If you have any quantitative result, you should show a viewgraph. Here are some basic rules. Most often I see the font size rule and the contrast rule violated.

Make sure the plot clearly shows exactly the message that you want to get across (if any).
Here is a view graph. Now it is important that you present it so it is understandable. Don't forget that you have seen it a million times but the audience has not. So they need guidance. Proceed in the steps shown above. I'll do it for the plot shown.

- In this plot we compare the performance of Spiral and IPP.
- The x-axis shows ..., the y-axis shows.
- This means higher is better (or vice-versa).
- For example, this datapoint means that ....

Now you can explain more.

Then conclude.

But this plot is rather mediocre ...

Here is a view graph. Now it is important that you present it so it is understandable. Don't forget that you have seen it a million times but the audience has not. So they need guidance. Proceed in the steps shown above. I'll do it for the plot shown.

- In this plot we compare the performance of single and double precision code for the discrete Fourier transform, namely Spiral-generated versus the IPP library.
- The x-axis shows the base-2 log of the DFT input size, so 5 means 32.
- The y-axis show the performance in Mflop/s (I know the audience knows what this is), so higher is better.
- Now I point to one data point and explain what this means. E.g., for k=4, the triangle shows that Spiral's double precision code runs at 1300 Mflop/s, which is more than twice as fast as IPPs code (500 Mflop/s).

Now you can proceed by talking about everthing you want. Then you can conclude. Here: Overall, Spiral-generated code is about twice as fast as IPP.

The plot is rather ugly. And see how the legend is placed somewhat randomly.
Here is an attractive plot. Study it for a bit and try to verbalize why. Also, try to find design decisions that you maybe have never thought about trying.
Most of the design decisions I stole from The Economist.

Example I: Good Viewgraph

Mid-semester grades 18-645, spring 2008

<table>
<thead>
<tr>
<th>grade</th>
<th>number of people</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>12</td>
</tr>
<tr>
<td>A-</td>
<td>10</td>
</tr>
<tr>
<td>B</td>
<td>8</td>
</tr>
<tr>
<td>C</td>
<td>6</td>
</tr>
<tr>
<td>D</td>
<td>4</td>
</tr>
</tbody>
</table>
Here is an explanation of the main features. Interestingly, most are based on principles we already learned. Most surprising to me when I learned it was the following:

- There is no reason to have the y-axis label vertical. And if you think for a while it does not make sense at all. One simply has a hard time reading a vertical label. As done above, it is perfectly clear that the y-axis is the number of people.

- You do not need a y-axis, at least not here.

Besides that, note how contrast is use to create a layering effect. The data is at the fore (as it should), and the grid lines and everything else are in the back.

As Edward Tufte says: "Above else show the data" (see references on the last slide).
Here is a black & white plot since it was used for print publishing (in a presentation, color would be much better). We decided to invert the background since it separates the plot clearer from its surroundings in a paper.

The one possibly surprising feature is that there is no legend. In fact, if possible avoid a legend and put the description right into the plot. Think about how long it takes to parse the connection between lines and legend. Eyes go back and forth and back and forth ....

As done here it is immediate.
Data Presentation: Tables

- Omitted due to lack of time. See http://www.ece.cmu.edu/~pueschel/teaching/guides/guide-tables.pdf

There is much to be said about tables; and as with plots and presentations, it is not straightforward to make good tables. But again, some of the same principles we have already learned apply. See the above guide for a short introduction.
A brief note about Powerpoint.
I much prefer Powerpoint over any other software for making presentations. 2007 is in my opinion a major improvement and makes it much easier to create attractive presentations. As a mathematician, however, you may want to consider latex. A very nice style for slides is available in latex (my only major complaint is that the template uses too much of the real estate). But back to Powerpoint.

If you frequently make presentations, learn how to really use Powerpoint (or whichever tool you use). It is worth it. This includes the above tips.

---

**Basic Tips**

- Use Office 2007, it’s worth it
- Use Slide Master to set basic appearance
  - View → Slide Master
- Set “Snap objects to grid:” simplifies placement
  - Home → Arrange → Align → Grid Settings
- Use ruler to align text with bullets
  - View → Ruler, then pull tab stops
  - Avoids things like
    - *This is some text inside a bullet and badly aligned*
- Shift-enter for line break without new bullet
Presentation Overview

- Preparation and physical presentation
- Content
- The visual presentation
- Tools: Powerpoint
- Summary

As said above.
I introduced a couple of basic principles in this presentation. The first four apply to graphic design in general. The fifth is crucial in presentations, since it makes it possible to communicate complex technical content and it minimizes text, which is one of the key goals in making presentations. The last one is generally good practice. Let me briefly restate the main points:

**Alignment:** Don’t randomly place elements. Most should be aligned to something. If in doubt, try first left alignment.

**Contrast:** If you want that elements look different make them sufficiently different. For fonts change at least two attributes. With colors play around. E.g., warm against cold, dark against bright gives good contrast.

**Layering** means that in every visual you decide which elements should be in the foreground and design accordingly. Lesser important elements you put in the background, e.g., by making them for example gray or bright or both.

**Consistency** means that similar elements should be designed similarly. For example, use the same font throughout the talk. You may break the principle for emphasis.

**Visualization:** Try to display problem statement, your approach, your algorithm, complicated technical background, theorems, etc. Everything that works is allowed. Start from the way you think about things. **Minimize text more and more until you can create talks without text-only slides.**

**Acknowledgment** your co-authors (say their names), material borrowed from other sources, and related work.
Summary

- **Presenting well is very important**
  - There is only one chance to make a first impression
  - Gives you an edge over all the bad presentations out there

- **Most important:**
  - Prepare well
  - Visualize
  - Be understandable
  - Less is more
  - **Practice**

- **Over time acquire a basic understanding of good design**
  - Fonts, colors, alignment, contrast

- **Watch critically other presentations:**
  - *What is good, what isn’t? Can you verbalize it?*

I repeat the most important points. In your summary, consider repeating a key visual from your talk.

Take every opportunity to practice presentations and always give your best.

Watch other presentations and try to see what works and what not. **The best exercise is to try to verbalize why something looks good and why it does not.** Once you can verbalize it, it is under your control. Also, design is everywhere, so look at it. Look at viewgraphs in newspapers and magazines. Look at any form of design. E.g., posters in museums always look great. Spend a minute looking at the design decisions. Do you recognize some of the principles we talked about?

You cannot become a great presenter over night. Like everything else, **it takes practice and the desire to get better**, i.e., it does not happen automatically. I hope that with the few tips from this presentation you can get on your way to becoming a presenter that people remember. Good luck!

I am happy to hear about any comments. Email me (my website is below).

Cheers!
Markus
As I said in the beginning, I did not invent anything in this talk. Everything is collected from books. Here are a few of them that I consider particularly helpful. Check them out.

- Cliff Atkinson, *Beyond Bullet Points*, Microsoft Press, 2005
- Stephen Few, *Show Me the Numbers*, Analytics Press, 2004